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About Micriµm 
 
Micriµm provides high-quality embedded software components in the industry by way of engineer-friendly 
source code, unsurpassed documentation, and customer support. The companyôs world-renowned real-

time operating system, the Micriµm µC/ OS-II , features the highest-quality source code available for 

today's embedded market. Micriµm delivers to the embedded marketplace a full portfolio of embedded 

software components that complement µC/ OS-II . A TCP/IP stack, USB stack, CAN stack, File System 

(FS), Graphical User Interface (GUI), as well as many other high quality embedded components. 
MicriÕmôs products consistently shorten time-to-market throughout all product development cycles. For 
additional information on Micriµm, please visit www.micrium.com. 
 
 
 

About µC/ OS-II   

 

Thank you for your interest in µC/ OS-II .  µC/ OS-II  is a preemptive, real-time, multitasking kernel.  

µC/ OS-II  has been ported to over 45 different CPU architectures and now, has been ported to the 

Freescale Power Architecture MPC5554 CPU. 
 

µC/ OS-II  is small yet provides all the services you would expect from an RTOS: task management, time 

and timer management, semaphore and mutex, message mailboxes and queues, event flags an much 
more. 
 

You will find that µC/ OS-II  delivers on all your expectations and you will be pleased by its ease of use. 

 
 
 

Licensing 
 

µC/ OS-II  is provided in source form for FREE evaluation, for educational use or for peaceful research.  If 

you plan on using µC/ OS-II  in a commercial product you need to contact Micriµm to properly license its 

use in your product.  We provide ALL the source code with this application note for your convenience and 

to help you experience µC/ OS-II .  The fact that the source is provided DOES NOT mean that you can 

use it without paying a licensing fee.  Please help us continue to provide the Embedded community with 
the finest software available.  Your honesty is greatly appreciated. 
 

http://www.micrium.com/
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Manual Version 
 
If any error is found in this document, please inform Micriµm in order for the appropriate corrections to be 
present in future releases. 
 

Version Date By Description 

V 1.00 2007/08/03 FGK Initial version. 

V 1.01 2007/08/14 FGK Added vectors.s  file for exception handling 

V 1.02 2009/09/18 FGK Chip brand corrections. 

 
 
 
 
 
 
 
 
 
 

Software Versions 
 
This document may or may not have been downloaded as part of an executable file containing the code 
described herein or any additional application or board support code.  If so, then the versions of the 
Micriµm software modules in the table below would be included.  In either case, the software port 
described in this document uses the module versions in the table below 
 

Module Version Comment 

µC /OS-II  V2.84  
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1.00  Introduction 
 

This document describes the official Micriµm port for µC/ OS-II  to the Freescale MPC5554 on 

CodeWarrior and GNU toolchains.  However, the information provided in this application note should be 
portable to other processors in the MPC55xx processor line. Figure 1-1 shows a block diagram with the 

relationship between your application, µC/ OS-II , the port code and the BSP (Board Support Package).  

Relevant sections of this application note are referenced on the figure.. 
 

 
 

Figure 1-1, Relationship between modules. 
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1.01  The Freescale MPC5554 
 
The MPC5500 family contains a host processor core that complies with the Power Architecture embedded 
category, which is 100 percent user mode compatible with the original Power PCÊ user instruction set 
architecture (UISA). The e200z6 CPU of the MPC5500 family is part of the family of CPU cores that 
implement versions built on the Power Architecture embedded category. This core also has additional 
instructions, including digital signal processing (DSP) instructions, beyond the classic Power ISA 
instruction set. 
 
 

 

Figure 1-2, Freescale MPC5554 Evaluation Board 

The MPC5554 has two levels of memory hierarchy. The fastest accesses are to the unified cache (32-
kilobytes). The next level in the hierarchy contains the 64-kilobyte internal SRAM and internal flash 
memory (2 MB flash). Both the internal SRAM and the flash memory can hold instructions and data 
 
The complex I/O timer functions of the MPC5500 family are performed by an enhanced time processor 
unit engines (eTPU). Each of the two eTPU engines control 32 hardware channels. The eTPU has been 
enhanced over the TPU by providing 24-bit timers, double action hardware channels, variable number of 
parameters per channel, angle clock hardware, and additional control and arithmetic instructions. The 
eTPU can be programmed using a high-level programming language. 
 
The less complex timer functions of the MPC5500 family are performed by the enhanced modular 
input/output system (eMIOS). The eMIOSô 24 hardware channels are capable of single action, double 
action, pulse width modulation (PWM) and modulus counter operation. Motor control capabilities include 
edge-aligned and center-aligned PWM. 
 
Off-chip communication is performed by a suite of serial protocols including three controller area networks 
(FlexCANs), four enhanced deserial/serial peripheral interface (DSPI), two enhanced serial 

UART 0 

JTAG 

 
R12 

 

Reset 

 
R12 

 
 
 

LR 

 

Power Switch & 
Power Supply 

LEDôs 

Freescale MPC5554 
MPC5554MVR132 

 

Push Buttons 



µC/ OS-II  for the MPC5554 

8 

Micriµm  

communications interfaces (eSCIs). The DSPIs support pin reduction through hardware serialization and 
deserialization of timer channels and general-purpose input/output (GPIO) signals. 
 
The MCU of the MPC5554 has an on-chip 40-channel enhanced queued dual analog-to-digital converter 
(eQADC). 
 
The system integration unit (SIU) performs several chip-wide configuration functions. Pad configuration 
and general-purpose input and output (GPIO) are controlled from the SIU. External interrupts and reset 
control are also found in the SIU. The internal multiplexer submodule (SIU_DISR) provides multiplexing of 
eQADC trigger sources, daisy chaining the DSPIs, and external interrupt signal multiplexing. 
 
The high performance e200z6 core with a rich set of peripheral functions of the MPC5554 makes 
designed for automotive embedded controls, like engine management, advanced driver assistance, 
central body and gateway applications. 
 
The Freescale MPC5554 evaluation board, shown in figure 1-2, has eight user LEDs, eight user position 
switches, four push buttons, two potentiometers, a speaker with a volume knob, a UART connector, a 

CAN connector, and a LIN connector. For the µC/ OS-II  application, the user LEDs 1 to 8 are wired to 

EMIOS12, EMIOS15, EMIOS13, EMIOS11, EMIOS18, EMIOS16, EMIOS17, and EMIOS21 respectively. 
The SW1 is wired to EMIOS14. 
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2.00  µC/ OS-II  Port for Freescale MPC5554 

 

The port for the Freescale MPC5554 processors assumes that a µC/ OS-II  V2.84 or higher is being used. 

 
 
 

2.01  Directories and Files 
 
The software described in this section of this application note is assumed to be placed in the following 
directories: 
 
 \ Micrium \ Software \ uCOS- II \ Ports \ MPC55xx\ GNU  

 
 \ Micriu m\ Software \ uCOS- II \ Ports \ MPC55xx\ MWERKS  

 

Like all µC/ OS-II  ports, the source code for the port is found in the following files:  

 
 OS_CPU.H  Section 2.02 

 OS_CPU_C.C  Section 2.03 

 OS_CPU_A.S  Section 2.04 

 OS_DBG.C  Section 2.05 

 
Test code and configuration files are found in their appropriate directories and are described later.  
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2.02  OS_CPU.H 
 
OS_CPU.H contains processor- and implementation-specific #defines  constants, macros, and 

typedefs .  

 
 
 

2.02.01  OS_CPU.H, macros for óexternalsô 
 
OS_CPU_GLOBALS and OS_CPU_EXT allow to declare global variables that are specific to this port.  

However, this port does not contain any global variables but the declarations have been included for future 
use. 
 
 
#ifdef  OS_CPU_GLOBALS  

#define OS_CPU_EXT  

#else  

#define OS _CPU_EXT  extern  

#endif  

Listing 2-1, OS_CPU.H, Globals and Externs 

 
 
 

2.02.02  OS_CPU.H, Data Types 
 

All data types used on the µC/ OS-II  port are referenced from the µC/ CPU . This allows a coherent data 

type scheme between CPU- and OS-specific code sections. µC/ CPU  port files are described later. 

 
 
typedef  CPU_BOOLEAN    BOOLEAN;  

typedef  CPU_INT08U     INT8U;  

typedef  CPU_INT08S     INT8S;  

typedef  CPU_INT16U     INT16U;  

typedef  CPU_INT16S     INT16S;  

typedef  CPU_INT32U     INT32U;  

typedef  CPU_INT32S     INT32S;  

typedef  CPU_FP32       FP32;  

typedef  CPU_FP64       FP64;  

 

typedef  CPU_STK        OS_STK;  

typedef  CPU_SR         OS_CPU_SR;  

Listing 2-2, OS_CPU.H, Data Types 
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2.02.03  OS_CPU.H, Critical Sections 
 

µC/ OS-II , as with all real-time kernels, needs to disable interrupts in order to access critical sections of 

code and re-enable interrupts when done.  µC/ OS-II  defines two macros to disable and enable interrupts: 

OS_ENTER_CRITICAL()  and OS_EXIT_CRITICAL() , respectively.  µC/ OS-II  defines three ways to 

disable interrupts.  The book (MicroC/OS-II, The Real-Time Kernel) describes the three different methods.  
The one to choose depends on the processor and compiler.  In most cases, the preferred method is 
OS_CRITICAL_METHOD #3. 

 
OS_CRITICAL_METHOD #3 implements OS_ENTER_CRITICAL()  by writing a function that will save the 

status register of the CPU in a variable and forces a global interrupt disable.  OS_EXIT_CRITICAL()  

invokes another function to restore the status register with its previous value before disabling interrupts.  

µC/ OS-II  uses the critical section implementation from the µC/ CPU  port, which are described later. 

 
 
#define  OS_CRITICAL_METHOD     CPU_CRITICAL_METHOD  

 

#define  OS_ENTER_CRITICAL()   (CPU_CRITICAL_ENTER())  

#define  OS_EXIT_CRITICAL( )    (CPU_CRITICAL_EXIT())  

Listing 2-3, OS_CPU.H, OS_ENTER_CRITICAL()  and OS_EXIT_CRITICAL()  

 
Note that if the application code uses these macros, and OS_CRITICAL_METHOD is #3 , a local variable 

called cpu_sr  MUST be declared and initialized to 0, as shown in listing 2-4: 

 
 
#if OS_CRITICAL_METHOD == 3                 /* Allocate storage for CPU status register */  

    OS_CPU_SR  cpu_sr = 0;  

#endif  

Listing 2-4, Local storage for Critical Method #3 
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2.02.04  OS_CPU.H, Task Level Context Switch 
 

Task level context switches are performed when µC/ OS-II  invokes the macro OS_TASK_SW().  Because 

context switching is processor specific, OS_TASK_SW() needs to halt the CPU execution flow; detect if 

any higher priority task is waiting to be executed; if so, switch to the higher priority task; and, reestablish 
CPU execution flow.  In this case, a supervisor call (SC) instruction is used to create an exception.  The 

benefit of using a SC is that it does not alter the CPU registers when OS_TASK_SW() is called.  More 

information on exception handling is available in the section Handling Exceptions and Interrupts. 
 
 
#define  OS_TASK_SW()          asm __volatile__ (" sc ")  

Listing 2-5a, OS_CPU.H, Task Level Context Switch (GNU) 

#define  OS_TASK_SW()          asm  (" sc ")  

Listing 2-5b, OS_CPU.H, Task Level Context Switch (MWERKS) 

 
 
 

2.02.05  OS_CPU.H, Stack growth 
 
The stack on the MPC5554 grows from high memory to low memory and thus, OS_STK_GROWTH is set to 

1 to indicate this to µC/ OS-II . 

 
 
#define  OS_STK_GROWTH        1  

Listing 2-6, OS_CPU.H, Stack Growth 

 

2.02.06  OS_CPU.H, Reserved Stack Size 
 
According to the application binary interface (ABI) for the Power ISA, a small stack area at the beginning 
of the stack must be reserved. This is done by the OSTaskStkInit()  function. The size of this reserved 

space is specified by OS_STK_RSVD_SIZE . 

 
 
#define  OS_STK_ RSVD_SIZE        10 

Listing 2-7, OS_CPU.H, Reserved Stack Size 
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2.02.07  OS_CPU.H, Function Prototypes 
 
As of V2.77, the prototypes for OSCtxSw() , OSIntCtxSw() , and OSStartHighR dy()  need to be 

placed in OS_CPU.H, since these are all port specific files.  OSCtxSw() , OSCtxRestore() , 

OSIntCtxRestore() , OSTickISR () , and OSExtIntISR ()  are declared in OS_CPU_A.S. 

 
 
void    OSCtxSw(void);  

void    OSIntCtxSw (void);  

void    OSStartHighRdy (void);  

 

void    OSTickISR (void);  

void    OSExtIntISR (void);  

Listing 2-8, OS_CPU.H, Function Prototypes 

The functions OSExtIntISR ()  and OSTickISR ()  are responsible for handling the External Interrupt 

and the Decrementer exceptions, respectively. 
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2.03  OS_CPU_C.C 
 

A µC/ OS-II  port requires ten fairly simple C functions: 

 
OSInitHookBegin()  

OSInitHookEnd()  

OSTaskCreateHook()  

OSTaskDelHook()  

OSTaskIdleHook()  

OSTaskStatHook()  

OSTaskStkInit()  

OSTaskSwHook()  

OSTCBInitHook()  

OSTimeTickHook()  

 

Typically, µC/ OS-II  only requires OSTaskStkInit() .  The other functions allow the functionality of the 

OS to be extended with user-defined functions.  The highlighted functions are discussed in this section. 
 

IMPORTANT 
 
In order for the compiler to use the functions declared in this file, the #define constant 
OS_CPU_HOOKS_EN needs to be set to 1 in OS_CFG.H. 

 
 
 
 
 
 
 

2.03.01  OS_CPU_C.C, OSInitHookBegin() 
 

This function is called by µC/ OS-IIôs OSInit()  at the very beginning of OSInit() .  It gives the 

opportunity to add additional initialization code specific to the port.  In this case, the global variable (global 
to OS_CPU_C.C) OSTmrCtr  is initialized (which is used by the OS_TMR.C module, if OS_TMR_EN is set to 

1). 

 
 
void  OSInitHookBegin  (void)  

{  

#if (OS_VERSION >= 281) && (OS_T MR_EN > 0)  

    OSTmrCtr = 0;  

#endif  

}  

Listing 2-9, OS_CPU_C.C, OSInitHookEnd()  
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2.03.02  OS_CPU_C.C, OSTaskCreateHook() 
 

This function is called by µC/ OS-IIôs OSTaskCreate()  or OSTaskCreateExt()  when a task is 

created.  OSTaskCreateHook()  gives the opportunity to add code specific to the port when a task is 

created.  In this case, the application hook, App_TaskCreateHook()  may be called if the #define 

OS_APP_HOOKS_EN 1 is included in the OS_CFG.H of the application. The application hooks are often 

used by optional modules, such as µC/ Probe  (a Real-Time Embedded Monitoring tool, see 

www.Micrium.com for details) and µC/ OS-View  (an optional module available for µC/ OS-II  which 

performs task profiling at run-time, see www.Micrium.com for details). 
 
Note that if OS_APP_HOOKS_EN is 0, the ptcb  is not actually used and it is added in the body of the 

function (i.e. (void)ptcb) ) to avoid a compiler warning. 

 
 
void OSTaskCreateHook  (OS_TCB * ptcb)  

{  

#if OS_APP_HOOKS_EN > 0  

    App_TaskCreateHook(ptcb);  

#else  

    (void)ptcb;  

#endif  

}  

 

Listing 2-10, OS_CPU_C.C, OSTaskCreateHook()  

 
 

2.03.03  OS_CPU_C.C, OSTaskStkInit() 
 
A task is declared as shown in listing 2-11. 
 
 
void  MyTask (void *p_arg)  

{  

    /* Do something with óp_argô, optional */ 

    while (1) {  

        /* Task body */  

    }  

}  

Listing 2-11, µC/ OS-II  Task 

The code in listing 2-12 initializes the stack frame for the task being created.  The task received an 
optional argument óp_arg ô.  For this architecture, óp_arg ô is passed in R3 when the task is created.  The 

initial value of most of the CPU registers are not important, thus they are initialized to values 
corresponding to their register number.  This makes it convenient when debugging and examining stacks 
in RAM.  The initial values are useful when the task is first created but, the register values will change as 
the task code is executed.  
 
The óTask bodyô MUST call either one of the OS???Pend()  functions or OSTimedly???()  functions.  In 

other words, a task MUST always be waiting for an event to occur.  An event can be the reception of a 
signal or a message from another task or ISR, or simply be a wait for the passage of time. If the task body 
does not perform any of these function calls, the OS will never have an opportunity to switch between 
different tasks. 
 

http://www.micrium.com/
http://www.micrium.com/
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OS_STK  * OSTaskStkInit  (void (*task)(void *pd), void *p_arg, OS_STK *ptos, INT16U opt)  

{  

    OS_STK     *stkp;  

    OS_CPU_SR   msr;  

    OS_CPU_SR   srr1;  

 

 

    (void)opt;  

    msr     =  CPU_SR_Rd();  

    srr1    = (msr | 0x8000);  

 

    stkp    = (OS_STK *)((INT32U) ptos & (INT32U) 0xFFFFFFF0);  

    stkp   - =  OS_STK_RSVD_SIZE;  

 

    * -- stkp = (INT32U)msr;                                /* MSR                             */  

    * -- stkp =  0;                                          /* EABI padding                    */  

    * -- stkp = 0;                                          /* EABI padding                    */  

    * -- stkp = 0;                                          /* SPEFSCR                         */  

    * -- stkp = (INT32U)task;                               /* LR                              */  

    * -- stkp = 0;                                          /* CR                              */  

    * -- stkp = 0;                                          /* XER                             */  

    * -- stkp = 0;                                          /* CTR                             */  

    * -- stkp = 0;                                          /* USPRG0                          */  

    * -- stkp =  (INT32U)srr1;                               /* SRR1                            */  

    * -- stkp = (INT32U)task;                               /* SRR0                            */  

    * -- stkp = 0;                                          /* R0                              */  

 

#ifdef OS_SAVE_CONTEXT_WITH_FPRS                          /* Push 64 - bit register in to stack  */  

    * -- stkp = 0x31L;                                      /* r31                             */  

    * -- stkp = 0x3100L;  

    * -- stkp = 0x30L;                                      /* r30                             */  

    * -- stkp = 0x3000L;  

{é} 

    * -- stkp = 0x14L;                                      /* r14                             */  

    * -- stkp = 0x1400L;  

    * -- stkp = (INT32U)&_SDA_BASE_;                        /* r13                             */  

    * -- stkp = 0x0000L;  

    * -- stkp = 0x12L;                                      /* r12                             */  

    * -- stkp = 0x1200L;  

{é} 

    * -- stkp = 0x4L;                                       /* r04                             */  

    * -- stkp = 0x4000L;  

    * -- stkp = (INT32U)p_arg;                              /* r03                             */  

    * -- stkp = 0x0000L;  

    * -- stkp = (INT32U)&_SDA2_BASE_;                       /* r02                             */  

    * -- stkp = 0x0000L;  

#else  

    * -- stkp = 0x31L;                                      /* r31                             */  

    * -- stkp = 0x30L;                                      /* r30                             */  

{é} 

    * -- stkp = 0x14L;                                      /* r14                             */  

    * -- stkp = (INT32U)&_SDA_BASE_;                        /* r13                             */  

    * -- stkp = 0x12L;                                      /* r12                             */  

{é} 

    * -- stkp = 0x4L;                                       /* r04                             */  

    * -- stkp = (INT32U)p_arg;                              /* r03                             */  

    * -- stkp = (INT32U)&_SDA2_B ASE_;                       /* r02                             */  

#endif  

    * -- stkp = 0;                                          /* BLANK for 0xA0 size             */  

    * -- stkp = (INT32U)ptos;                               /* Stack Ptr                       */  

 

    return(stkp);  

}  

Listing 2-12, OS_CPU_C.C, OSTaskStkInit()  
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IMPORTANT 
 
In order to enable/disable FPU support, the #define OS_SAVE_CONTEXT_WITH_FPRS 

MUST be changed accordingly both in OS_CPU.H and in OS_CPU_A.INC, in order to 

change all parts of FPU register saving and restoring. 

 
Figure 2-1 shows the stack frame initialization previously of each taskôs creation. 

 

Figure 2-1, The Initial Stack Frame for each Task. 
 

When the task is created, the final value of ptos  is placed in the OS_TCB of that task by the µC/ OS-II  

function that calls OSTaskStkInit()  (i.e. OSTaskCreate()  or OSTaskCreateExt() ). 

{RESERVED SPACE} 

 

MSR 

 

       0x00000000  

 

       0x00000000  

 

 

SPEFSCR = 0x00000000  

 

LR   = task  

 

CR   = 0x 00000000  

 

XER  = 0x 00000000  

 

CTR  = 0x00000000  

 

USPRG0 = 0x00000000  

SSR1 = MSR | MSR[EE]  

R31  = 0x00000031  

R14  = 0x00000014  

 

Stack Bottom  

Low Memory  

{é} 

R0   = 0x00000000  

SSR0 = task  

 

High Memory  

ptos (Top of Stack)  

 

EABI 
padding 

R13  = &_SDA_BASE_  

{é} 

 
R12  = 0x00000012  

R4   = 0x00000004  

 

R3   = p_arg  

       0x00000000  

 
R2   = &_SDA2_BASE_  

SP   = ptos  
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2.03.04  OS_CPU_C.C, OSTaskSwHook() 
 
OSTaskSwHook()  is called when a context switch occurs.  This function allows the port code to be 

extended to perform measures of the execution time of a task, output a pulse on a port pin when a context 
switch occurs, etc.  In this case, the application task switch hook, App_TaskSwHook() , is called. This 

assumes the #define OS_APP_HOOKS_EN 1 is included in the OS_CFG.H of the application.. 

 
 
void  OSTaskSwHook (void)  

{  

#if OS_APP_HOOKS_EN > 0  

    App_TaskSwHook();  

#endif  

}  

Listing 2-13, OS_CPU_C.C, OSTaskSwHook()  

 
 
 

2.03.05  OS_CPU_C.C, OSTimeTickHook() 
 
OSTimeTickHook()  is called at the very beginning of OSTimeTick() .  This function allows the port 

code to be extended by allowing a application time tick hook, App_TimeTickHook() , to be called. This 

assumes the #define OS_APP_HOOKS_EN 1  is included in the OS_CFG.H of the application.. 

 
 

OSTimeTickHook()  also determines whether it is time to update the µC/ OS-II  timers.  This is done by 

signaling the timer task. 
 
 
void  OSTimeTickHook  (void)  

{  

#if OS_APP_HOOKS_EN > 0  

    App_TimeTickHook();  

#endif  

 

#if (OS_VERSION >= 281) && (OS_TMR_EN > 0)  

    OSTmrCtr++;  

    if (OSTmrCtr >= (OS_TICKS_PER_SEC / OS_TMR_CFG_TICKS_PER_SEC)) {  

        OSTmrCtr = 0;  

        OSTmrSignal();  

    }  

#endif  

}  

Listing 2-14, OS_CPU_C.C, OSTimeTickHook()  



µC/ OS-II  for the MPC5554 

19 

Micriµm  

2.04  OS_CPU_A.S 
 

A µC/ OS-II  port requires that you write three assembly language functions for context switch and two 

assembly language functions for interrupt support.  These functions are needed because saving and 
restoring registers from C functions are not possible.  These functions are: 
 

OSCtxSw()  

OSInt Ctx Sw()  

OSStartHi ghRdy ()  

OSTickISR ()  

OSExtIntISR ()  

 
 
 

2.04.01  OS_CPU_A.S, OSCtxSw() 
 
A task level context switch occurs when a task is no longer able to run.  For example, if the code calls 
OSTimeDly(10) , then the current task needs to be suspended until 10  clock ticks expire.  Since the task 

can no longer run, µC/ OS-II  needs to find the next most important task ready to run and resume 

execution of that task.  The flow of code is as follows: 
 
The task calls OSTimeDly(10) ; 

 OSTimeDly()  calls OS_Sched() ; 

  OS_Sched()  disables interrupts; 

  OS_Sched()  finds the highest priority task that is ready to run; 

  OS_Sched()  calls invokes OS_TASK_SW()macro which performs a system call (SC); 

   SC vectors to OSCtxSw() ; 

   OSCtxSw()  performs the context switch; 

   Execution resumes in the new task; 
 
OSCtxSw()  simply consist of saving the CPU registers on stack of the task to suspend and restoring the 

CPU registers of the new task to resume from its stack. The pseudo-code for this is shown in listing 2-17. 
 
 
void  OSCtxSw (void)  

{  

    Save processor registers;  

 

    OSTCBCur- >OSTCBStkPtr =  SP;  

 

    OSTaskSwHook();  

 

    OSTCBCur              =  OSTCBHighRdy;  

    OSPrioCur             =  OSPrioHighRdy;  

 

    SP                    =  OSTCBHighRdy - >OSTCBStkPtr;  

 

    Restore processor registers ;  

    Return from supervisor call;  

}  

Listing 2-15, OSCtxSw()  pseudo-code 
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The code to perform a ótask levelô context switch is shown in listing 2-16, OSCtxSw() .  OSCtxSw()  is 

called when a higher priority task is made ready to run by another task or, when the current task can no 
longer execute (when it calls OSTimeDly() , OSSemPend()  and the semaphore is not available, etc 

 
OSCtxSw:                              ; (1)  

    prologue                          ; (2)  

 

    lis     r11, OSTCBCur@ha           ; (3)  

    lwz     r11, OSTCBCur@l(r11)  

    stw     r1, 0(r11)  

 

    bl      OSTaskSwHook              ; (4)  

 

    lis     r11, OSTCBHighRdy@ha       ; (5)  

    lwz     r11, OSTCBHighRdy@l(r11)  

 

    lis     r12, OSTCBCur@ha 

    stw     r11, OSTCBCur@l(r12)  

 

    lis     r12, OSPrioHighRdy @ha      ; (6)  

    lbz     r10, OSPrioHighRdy @l(r12)  

 

    lis     r12, OSPrioCur @ha 

    stb     r10, OSPrioCur @l(r12)  

 

    lwz     r1, 0(r11)                ; (7)  

 

    epilogue                          ; (8)  

 

    rfi                               ;  (9)  

Listing 2-16, OS_CPU_A.S, OSCtxSw()  

L2-16(1) System Call (SC) vectors to OSCtxSw() . 

 
L2-16(2) Processor registers are saved on prologue  macro, defined on OS_CPU_A.INC. 

 
L2-16(3) Stack pointer is saved on OSTCBCur. 

 
L2-16(4) Call to the user defined context switch hook, OSTaskSwHook() , is performed  

 
L2-16(5) OSTCBCur is overwritten by OSTCBHighRdy. 

 
L2-16(6) OSPrioCur  is overwritten by OSPrioHighRdy . 

 
L2-16(7) Stack pointer is restored from OSTCBHighRdy- >OSTCBStkPtr . 

 
L2-16(8) Processor registers are restored on epilogue  macro, defined on OS_CPU_A.INC. 

 
L2-16(9) Task ready to run becomes active. 

 



µC/ OS-II  for the MPC5554 

21 

Micriµm  

2.04.02  OS_CPU_A.S, OSIntCtxSw() 
 
When an ISR completes, OSIntExit()  is called to determine whether a more important task than the 

interrupted task needs to execute.  If that is the case, OSIntExit()  determines which task to run next 

and calls OSIntCtxSw() .  At this point, the ISR would have saved the CPU registers of the interrupted 

task and thus, all that is left to do is restore the CPU registers of the new task. 
 
 
OSInt CtxSw :  

    mbar    1                         ; ( 1)  

 

    bl      OSTaskSwHook              ; ( 2)  

 

    lis     r11, OSTCBHighRdy@ha       ; ( 3)  

    lwz     r11, OSTCBHighRdy@l(r11)  

 

    lis     r12, OSTCBCur@ha 

    stw     r11, OSTCBCur@l(r12)  

 

    lis     r12, OSPrioHighRdy @ha      ; ( 4)  

    lbz     r10, OSPrioHighRdy @l(r12)  

 

    lis     r12, OSPrioCur @ha 

    stb     r10, OSPrioCur @l(r12)  

 

    lwz     r1, 0(r11)                ; ( 5)  

 

    epilogue                          ; ( 6)  

 

    mbar    1  

 

    rfi                                ; ( 7)  

Listing 2-17, OS_CPU_C.C, OSIntCtxSw()  

 
L2-17(1) Instruction and memory synchronization. 
 
L2-17(2) Call to the user defined context switch hook, OSTaskSwHook() , is performed  

 
L2-17(3) OSTCBCur is overwritten by OSTCBHighRdy . 

 
L2-17(4) OSPrioCur  is overwritten by OSPrioHighRdy . 

 
L2-17(5) Stack pointer is restored from OSTCBHighRdy- >OSTCBStkPtr . 

 
L2-17(6) Processor registers are restored on epilogue  macro, defined on OS_CPU_A.INC. 

 
L2-17(7) Task ready to run becomes active. 
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2.04.03  OS_CPU_A.S, OSStartHighRdy() 
 
OSStartHighRdy()  is called by OSStart()  to start running the highest priority task that was created 

before calling OSStart() .  OSStart()  sets OSTCBHighRdy to point to the OS_TCB of the highest 

priority task. 
 
 
OSStartHighRdy :  

    bl      OSTaskSwHook              ; ( 1)  

 

    li      r0, 1                     ; (2)  

    lis     r11, OSRunning @ha 

    stb     r0, OSRunning @l(r11)  

 

    lis     r11, OSTCBHighRdy@ha       ; (3)  

    lwz     r11, OSTCBHighRdy@l(r11)  

 

    lis     r12, OSTCBCur@ha 

    stw     r11, OSTCBCur@l(r12)  

 

    lwz     r1, 0(r11)                ; ( 4)  

 

    epilogue                          ; ( 5)  

 

    rfi                               ; ( 6)  

Listing 2-18, OS_CPU_C.C, OSStartHighRdy()  

 
L2-18(1) Call OSTaskSwHook( ) .  The hook knows that a full context switch is NOT occurring by 

examining the value of OSRunning  which is set to OS_FALSE. 

 
L2-18(2) Once OSTaskSwHook()  is returned, OSRunning  is set to OS_TRUE which indicates that 

now the RTOS will be running. 
 
L2-18(3) OSTCBCur is overwritten by OSTCBHighRdy. 

 
L2-18(4) Stack pointer is restored from OSTCBHighRdy- >OSTCBStkPtr . 

 
L2-18(5) Processor registers are restored on epilogue  macro, defined on OS_CPU_A.INC. 

 
L2-18(6) Task ready to run becomes active. 
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2.05  Handling Exceptions and Interrupts 
 
The MPC5554 has a exception handling scheme that allows the exception vector table to be placed at any 
addressable memory section. This address which contains the base address of the exception vector table 
is stored in the IVPR (Interrupt Vector Prefix Register).  This port uses Software Interrupt Mode, therefore 

each exception has a IVPR-relative offset address stored on the IVOR (Interrupt Vector Offset Register) 

for the specific interrupt type. 
 
 
 

2.05.01  OS_CPU_A.S, Exception Handlers  
 
OS_CPU_A.S has the definitions for three exception handlers used on the MPC5554 port. The port 
utilizes IVOR4 (External Input Interrupt), IVOR8 (System Call Interrupt), and IVOR10 (Decrementer 

Interrupt). The IVOR4 register points to OSExtInt ISR()  function, IVOR8 to the OSCtxSw() , and 

IVOR10 to the OSTickISR () . These registers are initialized on BSP_INTC_Init() , defined on BSP.C.  

More details on the initialization function is found in the Board Support Package section. 
 
 
 

2.05.02  OS_CPU_A.S, OSExtIntISR()  
 
The MPC5554 has an interrupt controller which allows the CPU to vector directly to the appropriate 
interrupt service routine (ISR).  The MPC5554 maintains a vector table which can accommodate 308 
different interrupt source vectors.   
 
Prior to use any interrupt service, it is necessary to initialize the interrupt controller in the MPC5554.  This 
is accomplished by calling the function BSP_INTC_Init() .  Then, every interrupt service request can be 

register to be handled by a user-defined handler with the function BSP_INTC_IntReg() . These functions 

are described in detail in the Board Support Package section. 
 

For µC/ OS-II , EVERY ISR must be written as shown in the pseudo-code in listing 2-19. 
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My_ISR()                                             (1)  

    Disable ALL interrupts;                         (2)  

    Save ALL registers;           (3)  

    OSIntNesting++;            (4)  

    if (OSIntNesting == 1) {           (5)  

        OSTCBCur- >OSTCBStkPtr = SP;          (6)  

    }  

    /* Optionally, enabl e interrupts */              (7)  

    My_ISR_Handler();            (8)  

    OSIntExit();                                    (9)  

    Restore ALL registers                          (10)  

    Return from Exception;          (11)  

Listing 2-19, Pseudo-code for all ISRs under µC/ OS-II  

 
 
L2-19(1) Branch to the ISR have occurred. 
 
L2-19(2) Interrupts must be disabled because the code that follows must not be interrupted.  This 

is done because the preemption for higher priority interrupts may happen due to the 
nested interrupt capabilities of the MPC5554. Thus, for this point on, the code is 
guaranteed to be in a critical section. 

 
L2-19(3) All CPU registers are saved onto the interrupted taskôs stack. 
 
L2-19(4) Then, the interrupt nesting counter is incremented. OSIntNest ing  needs to be 

incremented by the ISR because OSIntExit()  checks the value of this counter to 

determine whether it will return to task level code or, the next nested ISR. 
 
L2-19(5)-(6) If this is the first nested ISR, then the taskôs stack pointer is saved onto the TCB (Task 

Control Block) of the interrupted task. 
 
L2-19(7) At this point, interrupts can be re-enabled to allow higher-priority interrupts to be nested. 
 
L2-19(8) Then call a user-defined C-level interrupt handler for the specific ISR.  In other words, it is 

NOT necessary to have ALL the ISR code in assembly language, only what is not 
possible to do in C.  Note also that the interrupt device must be cleared in the user-
defined interrupt handler to prevent óre-enteringô the interrupt when done. 

 

L2-19(9) The call to OSIntExit() allows µC/ OS-II  to determine whether the ISR (or any nested 

ISRs) made a more important task (than the interrupted task) ready-to-run.  If the 
interrupted task is still the most important task then OSIntExit()  will return to this ISR. 

 
L2-19(10)  If OSIntExit()  returns here, it means that the interrupted task is still the most important 

task.  Then, all the registers are restored from the interrupted taskôs stack. 
 
L2-19(11) The last step is to execute a return from exception instruction which causes the 

interrupted task to be resumed. 
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The process described above is shown graphically in Figure 2-2. 
 

 

Figure 2-2, Servicing Interrupts 
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The External Input Interrupt handler is responsible for branching to the user-defined interrupt handler. The 
INTC_IACKR register points to the user-defined interrupt handler address in the interrupt vector table. The 

source code for the External Input Interrupt handler is shown in listing 2-20. 
 
 
OSExtIntISR :                                         ;  (1)  

    prologue                                        ; (2 - 3)  

 

    lis     r11, OSIntNesting @ha                     ; (4)  

    lbz     r3, OSIntNesting @l(r11)  

    addi    r0, r3, 1  

    stb     r0, OSIntNesting @l(r11)  

 

    cmpwi   r0, 1                                   ; (5)  

    bne     OSExtIntISR _NotSaveSP  

 

    lis     r11, OSTCBCur@ha                         ; (6)  

    lwz     r11, OSTCBCur@l(r11)  

    stw     r1, 0(r11)  

 

OSExtIntISR _NotSaveSP:  

    lis     r3, INTC_IACKR@ha  

    lwz     r3, INTC_IACKR@l(r3)  

    lwz     r12,0(r3)  

 

    mtctr   r12  

    bctrl                                            ; (8)  

 

    li      r0, 0  

    lis     r3, INTC_EOIR@ha  

    stw     r0, INTC_EOIR@l(r3)  

 

    bl      OSIntExit                                ; (9)  

 

    epilogue                                        ; (10)  

   

    rfi                                             ; (11)  

Listing 2-20, OS_CPU_A.S, OSExtIntISR ()  

 
 
L2-20(1-11) The exception handler follows the pseudo-code on listing 2-19. Refer to its comments for 

details. Figure 2-2 describes graphically the functionality of the exception handler. 
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2.05.03  OS_CPU_A.S, OSTickISR()  
 
The Decrementer Timer available in the MPC5554 has a dedicated exception. This exception is 
associated with IVOR10. The clear the exception source, the timer status register (TSR) must have the 
DIS bit asserted.  The source code for the Decrementer exception is shown in listing 2-21. 
 
 
 
OSTickISR :                                           ; (1)  

    prologue                                        ; (2)  

 

    lis     r11, OSIntNesting @ha                     ; (3)  

    lbz     r3, OSIntNesting @l(r11)  

    addi    r0, r3, 1  

    stb     r0, OSIntNesting @l(r11)  

 

    cmpwi   r0, 1                                   ; (4)  

    bne     OSTickISR _NotSaveSP  

 

    lis     r11, OSTCBCur@ha                         ; (5)  

    lwz     r11, OSTCBCur@l(r11)  

    stw     r1, 0(r11)  

 

OSTickISR _NotSaveSP:  

    lis     r4, 0x0800                              ; (6)  

    mtspr   TSR,r4  

 

    bl      BSP_TmrTickISR                           ; (7)  

    bl      OSIntExit                                ; ( 8)  

 

    epilogue                                        ; ( 9)  

   

    rfi                                             ; (1 0)  

Listing 2-21, OS_CPU_A.S, ExceptHandler _IVOR10()  

 
 
L2-21(1) Branch to the ISR have occurred. 
 
L2-21(2) Interrupts are disabled and all CPU registers are saved onto the interrupted taskôs stack. 
 
L2-21(3) The interrupt nesting counter is incremented. 
 
L2-21(4)-(5) If this is the first nested ISR, then the taskôs stack pointer is saved onto the TCB (Task 

Control Block) of the interrupted task. 
 
L2-21(6) TSR[DIS] bit is clear (note that TSR bits are write-1-to-clear). 
 
L2-21(7) BSP_TmrTickISR() is called, which is a periodical time source function. 
 

L2-21(8) The call to OSIntExit() allows µC/ OS-II  to determine whether the ISR (or any nested 

ISRs) made a more important task (than the interrupted task) ready-to-run.  If the 
interrupted task is still the most important task then OSIntExit()  will return to this ISR. 

 
L2-21(9)  If OSIntExit()  returns here, it means that the interrupted task is still the most important 

task.  Then, all the registers are restored from the interrupted taskôs stack. 
 
L2-21(10) The last step is to execute a return from exception instruction which causes the 

interrupted task to be resumed. 
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2.06  OS_DBG.C 
 

os_dbg.c  is a file that has been added in µC/ OS-II  V2.62 to allow Kernel Aware debuggers to extract 

information about µC/ OS-II  and its configuration.  Specifically, os_dbg.c  contains a number of constants 

that are placed in ROM (code space) which the debugger can read and display.  If a debugger is not used, 
this file can be omitted from the project build. 
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3.00  µC/ CPU  Port for Freescale MPC5554 

 
This port holds CPU-specific definitions for the Freescale MPC5554 architecture. 
 
 
 

3.01  Directories and Files 
 
The software described in this section of this application note is assumed to be placed in the following 
directory: 
 
 \ Mi crium \ Software \ uC- CPU\ MPC55xx 

 
The section for each source code file is found as follows:  
 
 CPU.H   Section 3.02 

 CPU_A. S  Section 3.03 
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3.02  CPU.H 
 
CPU.H contains processor-specific #defines  constants, macros, and typedefs .  

 
 
 
 

3.02.01  CPU.H, Data Types 
 

All data types used on the µC/ OS-II  port are referenced from the µC/ CPU . This allows a coherent data 

type scheme between CPU- and OS-specific code sections. The complete data types list is shown in 
listing 3-1. 
 
 
typedef            void      CPU_VOID;  

typedef  unsigned  char      CPU_CHAR;               /*  8 - bit character            */  

typedef  unsigned  char      CPU_BOOLEAN;            /*  8 - bit boolean or logical   */  

typedef  unsigned  char      CPU_INT08U;             /*  8 - bit unsigned integer     */  

typedef    signed  char      CPU_INT08S;             /*  8 - bit   signed integer     */  

typedef  unsigned  short     CPU_INT16U;             /* 16 - bit unsigned integer     */  

typedef    signed  short     CPU_INT16S;             /* 16 - bit   signed integer     */  

typedef  unsigned  long      CPU_INT32U;             /* 32 - bit unsigned integer     */  

typedef    signed  long      CPU_INT32S;             /* 32 - bit   signed integer     */  

typedef            float     CPU_FP32;               /* 32 - bit floating point       */  

typedef            double    CPU_FP64;                /* 64 - bit floating point       */  

 

 

typedef            void    (*CPU_FNCT_VOID)(void);   /* Note 1                      */  

typedef            void    (*CPU_FNCT_PTR )(void *); /* Note 2                      */  

Listing 3-1, CPU.H, Data Types 

 
L3-1(1) Data type defined to replace commonly-used cast(s) for function pointers. Pointer to a 

function which returns void and has no arguments. 
 
L3-1(2) Data type defined to replace commonly-used cast(s) for function pointers. Pointer to a 

function which returns void and has a void pointer argument. 
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3.02.02  CPU.H, Critical Sections 
 

µC/ CPU  port defines two macros to enter and exit critical sections: CPU_CRITICAL _ENTER()  and 

CPU_CRITICAL_ EXIT() , respectively.  The book (MicroC/OS-II, The Real-Time Kernel) describes the 

three different methods for dealing with critical sections.  The one to choose depends on the processor 

and compiler.  The µC/ CPU  port implements only the critical method #3. 

 
The other critical method are not implemented and if selected as a critical method type, an error will abort 
the compilation of the project. 
 
 
typedef  volatile  CPU_INT32U  CPU_SR;                                    /* Note 1           */  

 

#define  CPU_CFG_CRITICAL_METHOD        CPU_CRITICAL_METHOD_STATUS_LOCAL   /* N ote 2           */  

 

#define  CPU_CRITICAL_ENTER()           { cpu_sr = CPU_SR_Save(); }        /* Note 3           */  

#define  CPU_CRITICAL_EXIT()            { CPU_SR_Restore(cpu_sr); }        /* Note 4           */  

Listing 3-2, CPU.H, CPU_CRITICAL_ENTER()  and CPU_CRITICAL_EXIT()  

 
L3-2(1) Defines CPU status register size. 
 
L3-2(2) Configure CPU critical method. 
 
L3-2(3) Call CPU_SR_Save()  to enter in a critical section. 

 
L3-2(4) Call CPU_SR_Restore ()  to exit a critical section. 
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3.02.03  CPU.H, Function Prototypes 
 
The prototypes in listing 3-3 are for CPU-specific assembly functions required from C-level. 
 
 
CPU_SR      CPU_SR_Save(void);  

void        CPU_SR_Restore (CPU_SR  cpu_sr);  

 

CPU_SR      CPU_SR_Rd(void);  

 

void        CPU_IntDis (void);  

void        CPU_IntEn (void);  

 

void        CPU_DEC_Set           (CPU_INT32U     val);  

void        CPU_DECAR_Set         (CPU_INT32U     val);  

CPU_INT32U  CPU_HID0_Get          (void);  

void        CPU_HID0_Set           (CPU_INT32U     val);  

CPU_INT32U  CPU_TBL_Get           (void);  

CPU_INT32U  CPU_TBU_Get           (void);  

void        CPU_TBL_Set           (CPU_INT32U     val);  

void        CPU_TBU_Set           (CPU_INT32U     val);  

CPU_INT32U  CPU_TCR_Get           (void);  

void        CPU_TCR_Set           (CPU_INT32U     v al);  

 

void        CPU_IVORxx _Set          (CPU_FNCT_VOID  fnct);  

Listing 3-3, CPU.H, Function Prototypes 

 
 
 

3.03  CPU_A.S 
 
CPU_A.S contains five assembly language functions for extending access to CPU registers to C-level.  

These functions are: 
 

CPU_SR_Save()  

CPU_SR_Restore ()  

 

CPU_SR_Rd() 

 

CPU_IntDis ()  

CPU_IntEn ()  

 

CPU_DEC_Set()  

CPU_DECAR_Set()  

CPU_HID0_Get()  

CPU_HID0_Set()  

CPU_TBL_Get()  

CPU_TBU_Get()  

CPU_TBL_Set()  

CPU_TBU_Set()  

CPU_TCR_Get()  

CPU_TCR_Set()  

 

CPU_IVORxx_Set()  
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3.03.01  CPU_A.S, Critical Sections 
 
CPU_A.S contains the assembly language functions for entering and exiting critical sections. The 

µC/ CPU  port implements only the critical method #3.  In Critical method #3, the status register of the 

CPU is saved in a local variable and all interrupts are disabled when a critical section is entered.  To leave 
a critical section, the status register previously saved in the local variable is restored. By restoring the 
previous value of the CPUôs status register, interrupts are only re-enabled if they were enabled just before 
entering the critical section. This guarantees nested critical sections to work properly. 
 
 
CPU_SR_Save:  

    mfmsr   r3                                             ; (1)  

    wrteei  0                                              ; (2)  

    blr                                                    ; (3)  

Listing 3-4, CPU_A.S, CPU_SR_Save()   

L3-4(1) Retrieve machine state register (MSR). 
 
L3-4(2) Disables interrupt by clearing EE bit in MSR. 
 
L3-4(3) Returns from subroutine. Note that this function returns R3 with the previous value of the 

MSR. 
 
CPU_SR_Restore :  

    mtmsr   r3                                             ; (1)  

    blr                                                    ; (2)  

Listing 3-5, CPU_A.S, CPU_SR_Restore ()   

L3-5(1) Restore MSR with its previous value . 
 
L3-5(2) Returns from subroutine. 
 
 
CPU_SR_Rd:  

    mfmsr   r3                                             ; (1)  

    blr                                                    ; (2)  

Listing 3-6, CPU_A.S, CPU_SR_Rd()   

L3-6(1) Retrieve machine state register (MSR). 
 
L3-6(2) Returns from subroutine. Note that this function returns R3 with the current value of the 

MSR. 
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3.03.02  CPU_A.S, Disabling and Enabling Interrupts 
 
Interrupts can be disabled and enabled using the CPU_IntDis()  and CPU_IntEn()  functions. The code 

for these functions are shown in listing 3-6 and listing 3-7, respectively. 
 
 
CPU_IntDis :  

    wrteei  0                                              ; ( 1)  

    blr                                                    ; ( 2)  

Listing 3-7, CPU_A.S, CPU_IntDis ()   

 
L3-7(1) Disables interrupt by clearing EE bit in MSR. 
 
L3-7(2) Returns from subroutine. 
 
 
 
CPU_Int En:  

    wrteei  1                                              ; ( 1)  

    blr                                                    ; ( 2)  

Listing 3-8, CPU_A.S, CPU_IntEn ()   

 
L3-8(1) Enables interrupt by setting EE bit in MSR. 
 
L3-8(2) Returns from subroutine. 
 
 
 

3.03.03  CPU_A.S, Interrupt Vector Offset Registers 
 
The MPC5554 has defined registers for different interrupt types. These registers are referenced by 
Interrupt Vector Offset Registers (IVOR). A list of functions is provided to access these registers from C-
level. Listing 3-9 shows a generic code for writing to a IVOR. 
 
 
CPU_IVORxx _Set :                                            ; (1)  

    mtIVORxx  r3                                            ; (2)  

    blr                                                    ; ( 3)  

Listing 3-9, CPU_A.S, CPU_IVORxx _Set ()   

 
L3-9(1) The xx reflects the interrupt vector offset register number on each function. 
 
L3-9(2) Write value into IVOR number defined by xx. 
 
L3-9(3) Returns from subroutine. 
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3.03.04  CPU_A.S, Special-Purpose Registers 
 
The MPC5554 has several special-purposes registers (SPR) that need to be accessed for different 
reasons during the execution or initialization of the board. The following functions provide C-level access 
for reading from and writing to these registers. A generic code for reading from a SPR is shown in listing 
3-10. Listing 3-11 shows a generic code for writing to a SPR. 
 
 
CPU_SPR_Get :                                                ; (1)  

    mfspr   r3,  SPR                                        ; ( 2)  

    blr                                                    ; ( 3)  

Listing 3-10, CPU_A.S, CPU_SPR_Get ()   

 
L3-10(1) The SPR reflects the special-purpose register name in each function. 
 
L3-10(2) Retrieve SPR value from special-purpose register number defined by SPR. 
 
L3-10(3) Returns from subroutine. 
 
 
 
CPU_SPR_Set :                                                ; (1)  

    mt spr   SPR, r3                                        ; ( 2)  

    blr                                                    ; ( 3)  

Listing 3-11, CPU_A.S, CPU_SPR_Set ()   

 
L3-11(1) The SPR reflects the special-purpose register name in each function. 
 
L3-11(2) Write special-purpose register defined by SPR with a new value. 
 
L3-11(3) Returns from subroutine. 
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4.00  BSP  (Board Support Package) for Freescale MPC5554 

 
It is often convenient to create a Board Support Package (BSP) for the target hardware.  A BSP allows the 
encapsulation of commonly used functionality which eases the application port, since the functions 
provided can be freely used by the application. A BSP can usually supports the following functionality: 
 
 Configuration of CPU and peripheral clock frequencies; 
 Determine CPU and peripheral clock frequencies;  
 Configure the LED I/Os; 

 Configuration and handling of the µC/ OS-II  tick timer; 

 Interrupt handling for the µC/ OS-II  tick timer; 

 Initialization of the serial communication channel; 
 Configuration and handling of timers; 
 Interrupt handling for serial data transfers; 
 Configuration of the interrupt services; 
 General I/O access functions. 
 
The BSP consist of 2 files: BSP.C and BSP.H. 

 
 

4.01  Directories and Files 
 
The software described in this section of this application note is assumed to be placed in the following 
directory: 
 
 \ Micrium \ Software \ EvalBoards \ Freescale \ MPC5554\ GNU\ BSP 

 
 \ Micrium \ Software \ EvalBoards \ Freescale \ MPC5554\ MWERKS\ BSP 

 
The section for each source code file is found as follows:  
 
 BSP.H, BSP.C  Section 4.02 

 VECTORS. S  Section 4.03 

 Header Files  Section 4.04 
 Initialization Files Section 4.05 
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4.02  BSP.H & BSP.C 
 
The BSP implements several global functions to give the application access to important services 
available in the target board.  Also, several local functions are defined to perform some atomic duty, such 

as clock setup, initialization of the interrupt controller, LEDôs, µC/ OS-II  tick timer, amount others.  The 

discussion of the BSP will be limited to the global functions that might be called from the application code. 
 
 
 

4.02.01  BSP, BSP_Init() 
 
The application code must call BSP_Init()  to initialize the BSP.  BSP_Init()  is responsible for the 

initialization of the services provided by the BSP. 
 
 
void  BSP_Init  (voi d)  

{  

    BSP_INTC_Init();                                           /* ( 1)                           */  

 

#if (uC_PROBE_COM_MODULE > 0)  

    BSP_INTC_IntReg(&BSP_USARTRxTxISR, BSP_IRQ_USART, 1);      /* ( 2)                           */  

#endif  

 

    LED_Init();                                                 /* ( 3)                           */  

 

    BSP_TmrInit();                                             /* ( 4)                           */  

}  

Listing 4-1, BSP.C, BSP_Init()  

L4-1(1) Initialize Interrupt support. 
 

L4-1(2)  If µC/ Probe  is part of the project build (uC_PROBE_COM_MODULE is set to 1 in the 

OS_CFG.H), then register serial data transfer interrupt handler. 

 
L4-1(3) Initialize LED service. 
 

L4-1(4)  Initialize µC/ OS-II  timer tick service. 
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4.02.02  BSP, BSP_INTC_Init() 
 
This function initializes the interrupt controller with all interrupts using the unhandled interrupt user-
handler. Therefore, if a non-registered interrupt becomes active, it will be caught by the unhandled 
interrupt user-handler. 
 
 
static  vo id  BSP_INTC_Init  (void)  

{  

    CPU_INT32U  i;  

 

 

    BSP_ExceptInit();                                           ; (1)  

 

    CPU_IVOR4_Set( OSExtIntISR );                                 ; (2)  

    CPU_IVOR8_Set( OSCtxSw);                                     ; ( 3)  

    CPU_IVOR10_Set( OSTickISR );                                  ; ( 4)  

 

 

    for (i = 0; i < BSP_INTC_IRQS; i++) {                        ; (5)  

        BSP_INTC_Handlers[i] = BSP_INTC_IntUnhandled;  

    }  

     

     

    INTC.MCR.B.HVEN =  0;                                        ; (6)  

    INTC.MCR.B.VTES =  0;                                        ; (7)  

    INTC.IACKR.R    = (CPU_ADDR)&BSP_INTC_Handlers[0];           ; (8)  

    INTC.CPR.B.PRI  =  0;                                        ; (9)  

     

    CPU_IntE n();                                                 ; (10)  

}  

Listing 4-2, BSP.C, BSP_INTC_In i t()  

 
L4-2(1) Initialize exceptions with default exception handlers from vectors.s . 

 
L4-2(2) Load OSExtIntISR ()  address into IVOR4 register (external interrupt). 

 
L4-2(3) Load OSCtxSw()  address into IVOR8 register (system call). 

 
L4-2(4) Load OSTickISR ()  address into IVOR10 register (decrement interrupt). 

 
L4-2(5) Loop thru all interrupt source and define the unhandled interrupt user-handler. 
 
L4-2(6) Initialize interrupt controller for software vector mode. 
 
L4-2(7) Use default vector table entry offset of 4-bytes. 
 
L4-2(8) Set interrupt controller ISR vector table base address. 
 
L4-2(9) Ensure current interrupt priority in interrupt controller is set to zero. 
 
L4-2(10) Enable interrupts. 
 
BSP_INTC_Init()  must be called prior to enable global interrupts, otherwise any unhandled interrupt will 

generate an unexpected behavior. 
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4.02.03  BSP, BSP_INTC_IntUnhandled() 
 
The BSP_INTC_IntUnhandled()  is an infinite loop that halts the execution of the code.  Under proper 

registration and activation of an interrupt service, BSP_INTC_IntUnhandled()  is never executed, since 

BSP_INTC_IntReg()  loads the user-defined handler for the specific interrupt service. The existence of 

BSP_INTC_IntUnhandled()  is for the case that an interrupt service has been activated but not 

registered with BSP_INTC_IntReg() . In this case, the execution is trapped by the  

BSP_INTC_IntUnhandled()  instead of branching to an unknown address in memory. 

 
 
static  void  BSP_INTC_IntUnhandled  (void)  

{  

    while (1) {  

        ;  

    }  

}  

Listing 4-3, BSP.C, BSP_INTC_Int Unhandled ()  
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4.02.04  BSP, BSP_INTC_IntReg() 
 
Once the interrupt support has been initialized by BSP_INTC_Init () , the application can freely register 

user-defined interrupt handlers for any interrupt request.  User-defined interrupt handlers are registered to 
an interrupt request by BSP_INTC_IntReg() .  

 
 
CPU_INT32U  BSP_INTC_IntReg  (CPU_FNCT_PTR handler, CPU_INT32U irq, CPU_INT32U int_level)  

{  

    if(i rq >= BSP_INTC_IRQS) {                         ; (1)  

        return (BSP_INTC_ERR_INVALID_IRQ);  

    }  

 

    INTC.PSR[irq].B.PRI    = int_level % 15;           ; (2)  

 

    BSP_INTC_Handlers[irq] = handler;                  ; (3)  

 

    return (BSP_INTC_ERR_NONE);  

}  

Listing 4-4, BSP.C, BSP_INTC_IntReg()  

 
L4-4(1) Return an error if interrupt is out of the range. 
 
L4-4(2) Set interrupt priority register with given interrupt priority level. 
 
L4-4(3) Store interrupt handler in the interrupt handlersô table. 
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4.02.05  BSP, General-Purpose Input/Output service functions 
 
A GPIO line may be multiplexed with one or more peripheral functions. The BSP_GPIO_SetFnct ()  

configures the peripheral function of a pin. 
 
void  BSP_GPIO_SetFnct  (CPU_INT16U pin, CPU_INT08U fnct)  

{  

    SIU .PCR[pin].R = fnct;                               ; (1)  

}  

Listing 4-5, BSP.C, BSP_GPIO_SetFnct()  

L4-5(1) Configure the peripheral function of a GPIO. 
 
BSP_GPIO_SetPin() , BSP_GPIO_ClrPin() , and BSP_GPIO_TglPin() , shown in listing 4-6, are 

functions responsible for changing the logical level of a pin. These functions modify the level driven on an 
I/O line by altering the GPDO. Listing 4-7 shows the generic code for these functions. 
 
 
    void  BSP_GPIO_SetPin (CPU_INT16U pin);  

    void  BSP_GPIO_ClrPin (CPU_INT1 6U pin);  

    void  BSP_GPIO_TglPin (CPU_INT16U pin);  

Listing 4-6, BSP.C, GPIO control functions 

 
 
void  BSP_GPIO_???Pin  (CPU_INT16U pin)                         /* (1)                           */  

{  

    SIU.GPDO[pin].R = ??? ;                                     /* (2)                           */  

}  

Listing 4-7, BSP.C, BSP_GPIO_???Pin()  

 
L4-7(1) Each GPIO control function has its own definition: BSP_GPIO_SetPin() , 

BSP_GPIO_Clr Pin() , and BSP_GPIO_Tgl Pin() . 

 
L4-7(2) Set pin level based on the type of the GPIO functionality. 
 
 
 

4.02.06  BSP, LED service functions 
 
A number of evaluation boards are equipped with LEDôs. For this reason, the BSP has a collection of 
control functions which creates a standard access to the LEDôs from the application perspective. The LED 
control functions use internally the BSP_GPIO_???Pin()  control functions to change the state of the 

LEDôs. Listing 4-8 shows the available LED control functions. 
 
 
    void   LED_On(CPU_INT08U led);  

    void   LED_Off (CPU_INT08U led);  

    void   LED_Toggle (C PU_INT08U led);  

Listing 4-8, BSP.C, LED control functionsô prototypes 
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4.02.07  BSP, OS Timer functions 
 
 

The µC/ OS-II  clock tick ISR handler and its initialization function have been encapsulated in the BSP. 

This makes it easier to adapt the µC/ OS-II  port to different target hardware since these functions can be 

changed to select whichever timer or interrupt source for the clock tick that the application requires. 
 
The MPC5554 have decrementing timer and time base capabilities.  The decrementing timer also has 
interrupt capability. For this reason, it has been chosen as the OS tick source as oppose to dedicate any 
other available timer counters.  
 
To initialize the OS tick source, BSP_TmrInit()  must be called by the application code. Listing 4-9 

shows the function source code. 
 
 
static  void  BSP_TmrInit  (void)  

{  

    CPU_INT32U  cycles;  

    CPU_INT32U  hid0;  

    CPU_INT32U  tcr;  

 

 

    cycles = (CPU_CLK_FREQ() / OS_TICKS_PER_SEC);            ; (1)  

 

    CPU_DECAR_Set(cycles);                                   ; ( 2)  

    CPU_DEC_Set(cycles);                                     ; (3)  

 

    CPU_TBL_set(0);                                         ; (4)  

    CPU_TBU_Set(0);  

 

    hid0    =  CPU_HID0_Get();  

    hid0   |=  0x00004000;                                   ; (5)  

    CPU_HID0_Set(hid0);  

 

    tcr     =  CPU_TCR_Get();  

    tcr    |=  0x04400000;                                  ; (6)  

    CPU_TCR_Set(tcr);  

}  

Listing 4-9, BSP.C, BSP_TmrInit()  

 
L4-9(1)  Compute number of CPU cycles for every OS tick. 
 
L4-9(2)  Load number of cycles into Decrementer auto-load register (DECAR). 
 
L4-9(3)  Initialize Decrementer timer with number of cycles. 
 
L4-9(4)  Clear Time Base registers. 
 
L4-9(5)  Enable Time Base periodical increments. 
 
L4-9(6)  Enable interrupts and auto-reload function for Decrementer timer. 
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The BSP_TmrTickISR()  is responsible for signaling a clock tick to the OS. This function is called by the 

Decrementer exception handler, ExceptHandler_IVOR10() . The source code for 

BSP_TmrTickISR()  is shown in listing 4-10. 

 
 
void  BSP_TmrTickISR  (void)  

{  

    OSTimeTick() ;                                                               /* (1)           */  

}  

Listing 4-10, BSP.C, BSP_TmrTickISR()  

 
L4-10(1) Signal a clock tick to the OS. 
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4.03  VECTORS.S, Exception Vectors & Initialization 
 
 
The VECTORS.S contains exception handlers for interrupt vector offset registers zero to fifteen, and 
thirty-two to thirty-four (IVOR0-IVOR15, IVOR32-IVOR34).  To process an exception, either a modification 
to the empty exception handlers is necessary, or the address of a different handler can be passed to the 
proper interrupt vector offset register. 
 
The initialization of the default exception handlers are done on the BSP_ExceptInit()  function.  

 
 
BSP_ExceptInit:  

    lis      r3, __IV_ADDR@h                        ; (1)  

    mtIVPR   r3  

     

    lis      r3,     ExceptHandler_IVOR0@h          ; (2)  

    ori      r3, r3, ExceptHandler_IVOR0@l  

    mtIVOR0  r3  

{é} 

    lis      r3,     ExceptHandler_IVOR15@h         ; (3)  

    ori      r3, r3, ExceptHandler_IVO R15@l 

    mtIVOR15 r3  

 

    lis      r3,     ExceptHandler_IVOR32@h         ; (4)  

    ori      r3, r3, ExceptHandler_IVOR32@l  

    mtIVOR32 r3  

 

    lis      r3,     ExceptHandler_IVOR33@h         ; (5)  

    ori      r3, r3, ExceptHandler_IVOR33@l  

    mtIVOR33 r3  

 

    lis      r3,     ExceptHandler_IVOR34@h         ; (6)  

    ori      r3, r3, ExceptHandler_IVOR34@l  

    mtIVOR34 r3  

 

    blr  

Listing 4-11, VECTORS.S, BSP_ExceptInit ()  

 
L4-11(1) The high-word of Interrupt vector prefix register (IVPR) is loaded with __IV_ADDR. 

__IV_ADDR is defined in the linker command file with the address of the . xcptn  section, 

where the exception handlers are stored. 
 
L4-11(2-6) Interrupt vector offset registers zero to fifteen, thirty-two to thirty-four are loaded with the 

address of their respective exception handlers.. 
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4.04  Header Files 
 
 
This port for the MPC5554 uses the MPC55xx Header files provided by Freescale. The header files 
provide register and bit-fields definitions for MPC5554. The MPC55xx Header files can be found at 
Freescale website (www.Freescale.com). Go to the MPC5554 product page, and click on Design Tools. 
The header files are listed as ñMPC5500_HEADERò. 
 
The MPC55xx Header files are assumed to be placed in the following directories: 
 
 \ Micrium \ Software \ EvalBoards \ Freescale \ MPC5554\ GNU\ BSP\ MPC55xx 

 
 \ Micrium \ Software \ EvalBoards \ Freescale \ MPC5554\ MWERKS\ BSP\ MPC55xx 

 
 
 
 
 
 

4.05  Initialization Files 
 
 
This port for the MPC5554 uses the MPC55xx Initialization files provided by Freescale. The initialization 
files provide startup and configuration of the MPC5554. The MPC55xx Initialization files can be found in 
the MPC5500 Documentation CD available in the Evaluation Kit for the MPC5554EVB from Freescale. 
The file is located in the following directory: 
 
 CD\ SoftwareExamples \ Initialization Code \ MPC5500_Initialization_Code.zip  

 
The files necessary for the initialization procedure are the following: 
 
 MPC5500init - v1.1 \ src \ __start.s  

 MPC5500init - v1.1 \ src \ mpc5500_asmcfg.s  

 MPC5500init - v1.1 \ src \ mpc5500_ccdcfg.h  

 MPC5500init - v1.1 \ src \ mpc5500_ccdcfg.c  

 MPC5500init - v1.1 \ src \ mpc5500_defs.inc  

 MPC5500init - v1.1 \ src \ mpc5500_SRAM_load.s  

 MPC5500init - v1.1 \ src \ mpc5500_usrccdcfg.h  

 MPC5500init - v1.1 \ src \ mpc5500_usrdefs.inc  

 
This MPC55xx Initialization files are assumed to be placed in the following directories: 
 
 \ Micrium \ Software \ EvalBoards \ Freescale \ MPC5554\ GNU\ BSP\ Init  

 
 \ Micrium \ Software \ EvalBoards \ Freescale \ MPC5554\ MWERKS\ BSP\ Init  

 

http://www.freescale.com/
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5.00  Application Code 
 
The sample application code makes use of the port presented in this application note as described in this 
section. 
 
 
 
 

5.01  Directories and Files 
 
The software described in this section of this application note is assumed to be placed in the following 
directory: 
 
 \ Micrium \ Software \ EvalB oards \ Freescale \ MPC5554\ GNU\ OS\ App 

 
 \ Micrium \ Software \ EvalBoards \ Freescale \ MPC5554\ MWERKS\ OS 

 
The section for each source code file is found as follows:  
 
 APP. C   Section 5.02 

 APP_CFG. H  Section 5.03 

 INCLUDES. H  Section 5.04 

 OS_CFG. H  Section 5.05 
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5.02  APP.C 
 
The sample application code is placed in the file called APP.C.  An application can contain many more 

files.  APP.C is where the main()  is placed but, it could be placed in any other file in a final application. 

 

APP.C is a standard test file for µC/ OS-II  examples.  The two important functions are main()  (listing 5-

1) and AppTask Start ()  (listing 5-2). 

 
 
int  main  (void)  

{  

    INT8U  err;  

 

 

    CPU_IntDis ();  

 

    OSInit ();                                                                  /* (1)           */  

 

    OSTaskCreateExt (AppTask Start ,                                              /* (2)           */  

                    (void *)0,  

                    (OS_STK *)&AppTask Start Stk[APP_TASK_START_STK_SIZE -  1],  

                    APP_TASK_START_PRIO,  

                    APP_TASK_START_PRIO, 

                    (OS_STK *)& AppTask Start Stk [0],  

                    APP_TASK_START_STK_SIZE, 

                    (void *)0,  

                    OS_TASK_OPT_STK_CHK | OS_TASK_OPT_STK_CLR); 

 

#if (OS_TASK_NAME_S IZE > 7) && (OS_TASK_STAT_EN > 0)  

    OSTaskNameSet(APP_TASK_START_PRIO, (INT8U *)"Startup", &err);              /* (3)           */  

#endif  

 

    OSStart ();                                                                 /* (4)           */  

 

    return (0);  

}  

Listing 5-1, APP.C, main()  

 

L5-1(1)  As with all µC/ OS-II  based applications, the OS needs to be initialized by calling OSInit() . 

 
L5-1(2)  At least one task needs to be created.  In this case, a task is created using the extended task 

create call.  This allows µC/ OS-II  to have more information about the task. 

 
L5-1(3)  Tasks can be given a name and it can be displayed by the Kernel Aware debuggers. 
 
L5-1(4)  Call OSStart()  to start multitasking.  Note that OSStart()  does not return from this call. 
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stati c void  AppTask Start  (void *p_arg)  

{  

    INT8U  i;  

 

 

    (void)p_arg;                                                                /* (1)           */  

 

    BSP_Init ();                                                                 /* (2)           */  

 

#if O S_TASK_STAT_EN > 0  

    OSStatInit ();                                                               /* (3)           */  

#endif  

 

    AppTaskCreate ();                                                            /* ( 4)           */  

 

 

    while (1) {                                                                 /* ( 5)           */  

        for (i = 1; i <= 6; i++) {  

            LED_On(i);  

            OSTimeDlyHMSM(0, 0, 0, 200);  

            LED_Off (i);  

        }  

        for (i = 4; i <= 7; i++) {  

            LED_On( 9 -  i);  

            OSTimeDlyHMSM(0, 0, 0, 200);  

            LED_Off ( 9 -  i);  

        }  

    }  

}  

Listing 5-2, APP.C, AppTask Start ()  

 
L5-2(1)  Prevent compiler warning. 
 

L5-2(2)  Initializes the BSP (see Board Support Package section) for the target board. 
 

L5-2(3)  If task statistics is enable (OS_TASK_STAT_EN is set to 1 in the OS_CFG.H) then, the task 

statistics needs to be initialized.  Note that the µC/ OS-II  clock tick needs to be enabled and 

initialized because OSStatInit()  assumes the presence of clock ticks.  In other words, if 

the tick ISR is not active when OSStatInit()  is called, the application will end up in 

µC/ OS-IIôs idle task and not be able to run any other tasks. 
 

L5-2(4)  At this point, additional tasks can be created.  All task initialization is placed in one function 
called AppTaskCreate() . 

 

L5-2(5)  Additional function can be performed by this task. Note that in order to switch between tasks, 

the task MUST call either one of the OS???Pend()  functions or OSTimedly???()  functions.  

In other words, a task MUST always be waiting for an event to occur.  An event can be the 
reception of a signal or a message from another task or ISR, or simply be a wait for the 
passage of time. If the task does not perform any of these function calls, the OS will never 
have an opportunity to switch between different tasks. 
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5.03  APP_CFG.H 
 
APP_CFG.H  contains configuration options for the sample application code, such as #define  constants, 

macros, prototypes, etc. that are specific to the application. 
 
 
#define  APP _TASK_START_STK_SIZE          256            /* (1)                               */  

Listing 5-3, Stack sizes 

L5-3(1)  Depth of the stack for the sample application task. Note that the depth of the stack is in 
number of 32-bit registers it can hold. 

 
 
 
#defi ne  APP_TASK_START_PRIO                0           /* (1)                               */  

#define  OS_TASK_TMR_PRIO                   8           /* (2)                               */  

Listing 5-4, Task priorities 

L5-4(1)  Priority for the sample application task. Note that the lower the priority number, the higher the 
priority of the task. 

 
L5-4(2)  Priority for the OS Timer Management task. 
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5.04  INCLUDES.H 
 
INCLUDES.H is a master include file and it is found at the top of all .C  files.  INCLUDES.H allows every 

.C  file in the project to be written without concern about which header file is actually needed. The only 

drawbacks to have a master include file are that INCLUDES.H may include header files that are not 

pertinent to the actual .C  file being compiled and the compilation process may take longer. These 

inconveniences are offset by code portability.  The INCLUDES.H can be edited to include additional 

header files, but any addition should be added at the end of the list.  Listing 5-5 shows the typical contents 

of INCLUDES.H for a µC/ OS-II  project. 

 
 
#include      <stdarg.h>  

 

#include      <cpu.h>  

#include      <app_cfg.h>  

#include      <ucos_ii.h>  

 

#include      "mpc5500_usrccdcfg.h"  

#include      <bsp.h>  

Listing 5-5, INCLUDES.H 

 
 
 
 

5.05  OS_CFG.H 
 

This is the µC/ OS-II  configuration file for the project. The book (MicroC/OS-II, The Real-Time Kernel) 

describes the configuration elements for the µC/ OS-II . 

 
 
#define OS_TICKS_PER_SEC        10 00                     /* ( 1)                          */  

Listing 5-6, OS_CFG.H 

 
L5-6(1)  Number of OS time ticks occurring in one second. This value can be changed as needed 

but it is typically set between 10 and 1000 Hz.  The higher the tick rate, the more 

overhead µC/ OS-II  will impose on the application.  However, a higher tick rate has a 

better tick granularity. 
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6.00  Opening and Loading the Project 
 
The files located in the executable zip file named Micrium-Freescale-uCOS-II-MPC5554.exe are 
organized in the directory structure shown in Figure 6-1. The code files referred to herein follows the same 
directory structure. 
 
 

 

Figure 6-1, Directory Structure 

Projects are included for both Freescale CodeWarrior and Eclipse-based GNU . A CodeWarrior project 
file named OS.mcp is located in the CodeWarrior projectôs folder in the directory: 
 
\ Micrium \ Software \ EvalBoards \ Freescale \ MPC5554\ MWERKS\ OS 

 
To view this example project, start an instance of CodeWarrior for MPC55xx, and open the project file 
OS.mcp.  To do this, select the ñOpenò menu command under the ñFileò menu, select objects of type 

ñProject Filesò and mark the project file after navigating to the project directory.  In addition, the project file 
could also be opened by double-clicking on the file in a Windows Explorer window. 
 
An Eclipse-based GNU project is located in the directory: 
 
\ Micrium \ Software \ EvalBoards \ Freescale \ MPC5554\ GNU\ OS 

 
To view this example project, start an instance of Eclipse.  If the ñWorkspace Launcherò dialog appears, 
select a folder to import the project to (Ex.: My Documents\Workspacesò) by navigating to the project 
directory and select the workspace.  Otherwise, choose the ñSwitch Workspaceéò menu command under 
the ñFileò menu and select the workspace folder after navigating to the project directory. Next, go to 
ñImportò menu command under the ñFileò menu, select ñGeneral\Existing Projects into Workspaceò, 
browse for the Eclipse-based GNU project directory. A project ñOSò will be listed as available, do not 
check ñCopy projects into workspaceò and click ñFinishò. The file ñ.projectò under the Eclipse-based GNU 
project root folder must not be read-only, otherwise the project will fail to import. 
 

Licensing agreements 

(If µC/ OS-II  is used 

commercially) 

Contact 

www.Micrium.com 

for pricing 

AN-1054 

CodeWarrior 

Example Project 

µC/ OS-II  

The Real Time Kernel 
µC/ OS-II  

documentation 

µC/ OS-II  processor 

independent 

source code 

MPC55xx 

µC/ OS-II  port 

MPC55xx 

µC/ CPU  port 

Eclipse-based GNU 

Example Project 

http://www.micrium.com/
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6.01  The Freescale CodeWarrior Compiler 
 

This µC/ OS-II  port was tested using the Freescale CodeWarrior for MPC55xx V2.1 compiler.  The 

CodeWarrior IDE holds source files and libraries, manages dependencies and stores compiler, linker and 
other settings.  The CodeWarrior for MPC55xx is a compiler-only tool, it does not provide any debugging 
capabilities. 
 
Below are screen shots of some of the toolchainôs settings: 
 
 
 

 
 

Must specify this Linker 
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Header files search path 

MUST 
Select both 

checkboxes. 

MUST 
Select DWARF2 

debug information. 

MUST 
Select EABI. 
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Must specify alignment of 

16-bytes for functions 

Select Floating Point and 

Vector support 

You can select óanyô 

optimization level 
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Once all setting have been applied, the project is compiled under the submenu ñMake (F7)ò on the 
ñProjectò menu. The generated files are placed in the ñoutputò folder on the project root. 
 

ñUse Full Path Namesò to facilitate 

source files to be found be debugger 

MUST 
ñUse Linker Command Fileò 

MUST 
ñGenerate ROM Imageò to allow 

initialized data to be placed in ROM 

ñGenerate S-Record Fileò 

to flash the MPC5554 

using the P&E Multilink 
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6.02  Programmer/Debugger 
 
The MPC5554 evaluation board may be programmed and debugged through the 14-pin debug port 
named JTAG on the board. The evaluation board kit provides a P&E USB NEXUS Multilink for MPC55xx 

devices, shown in figure 6-2. The CodeWarrior Development Studio for MPC55xx uses external 
debugger. There is an evaluation version of the ICDPPCNEXUS Debugger from P&E which is limited to a 
128KB of code. This debugger is available through the CodeWarrior for MPC55xx Special Edition 
download. 
 

 

Figure 6-2, P&E USB Multilink 
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The P&E debugger can be launched directly from the CodeWarrior GUI. The following configurations 
settings must be present in the MPC55xx project. 

 

 
 
 
The arguments to load the executable into the internal flash memory are: 
 
OS.elf LOADTOFLASH - RESETFILE "C: \ Program Files \ Freescale \ CodeWarrior for 

MPC55xx V2.2 \ pemicro \ mpc5500_booke.mac"  

 

OS.elf  Name of projectôs executable. 
 

LOADTOFLASH Loads the debug/object files into the processor's flash memory. 
 

-RESETFILE 

"RESETFILEPATH"  

 

Specifies a reset macro file to run each time the processor is reset. 
 
A reset macro (or configuration file or script file) has the extension 
.mac. This file is necessary to configure the processor. The script 
file to use is mpc5500_booke.mac or mpc5500_vle.mac if the 
variable length encoding instructions are used. 
 
RESETFILEPATH must be an absolute path.  

 
The list of the possible arguments to P&E Debugger are located at menu: Help > CodeWarrior Help 

> Power Architecture Processor s > Targeting MPC55xx > P&E Debugger Adjustments  

> Command- Line Arguments.  

 

Select External 

Debugger 

P&E debugger path from 

CodeWarrior directory 

Directory of the current 

projectôs executable 
Arguments passed to 

the P&E debugger 
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The processor Boot Assist Module (BAM) normally initializes the processor.  However, when running the 
target application from the debugger, the BAM functionality is disabled.  Therefore, the initialization is done 
by the debugger running the reset script file on reset.  The script initializes the processor similarly to the 
BAM.  The script contents can be view and modified to any application specific needs. 
 

The P&E debugger is launched from CodeWarrior through the menu Project > Debug (F5) or .  

 
The following connection dialog box appears:  
 

 
 

P&E debugger detects 

automatically the USB 

Multilink if the board is on  

Click this button to connect 

the target and executing the 

script file (.mac) 
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When the connection has been established, P&E debugger launches cw_cprogppcnexus.exe  (located 

at pemicro  folder) to flash the executable into memory, as shown in the following figure: 

 

 
 
Finally, the reset script file executes to initialize the MMU (Memory Management Unit) and additional 

registers of the MPC5554. The Status Windows from P&E debugger returns control to the user who can 
now use the debugger commands. A command ógoô, for example, runs the application. The complete list 
of debugger commands are located at menu Help > Contents > Commands.  

 

 
 

Enter debugger commands 


